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!
Modus Trex™ is comprised of an ankle-worn ambulatory activity monitor (StepWatch™), 
docking station (dock), and software for viewing/printing functional assessment reports.  
The functional assessment report provides an overall functional score based on walking 
activity with the prosthesis in addition to other metrics (e.g. daily steps, distance 
walked, and cadence).  These reports will help you track your patients’ change in 
mobility. To use this system, you will need a computer running either a Windows Vista+ 
or Mac OS X 10.7+ operating system.
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I. General StepWatch™ Information and Care

The StepWatch™ Activity Monitor (U.S. Patent # 5,485,402) is a research and clinical tool for 
long-term assessment of ambulatory function in a home setting. It is an ankle-worn, 
microprocessor-controlled step counter which unobtrusively measures how mobile a person is 
throughout daily life. Step counts can be recorded for 50 days between downloads. However, if 
a patient takes tens of thousands of steps every day, it is possible to exhaust the memory of 
the StepWatch™ before 50 days has elapsed. 
!
The StepWatch™ Activity Monitor detects steps for a wide variety of normal and abnormal gait 
styles and cadences ranging from a slow shuffle to a fast walk.  The StepWatch™ has validated 
accuracy between 1 – 4 mph 1-29. When properly used, accuracy typically exceeds 98%. 
!
A body of published research demonstrates that functional differences in gait activity can be 
clearly and objectively measured with the StepWatch™ in a wide range of human populations. A 
bibliography listing of currently known publications is available at modushealth.com or contact 
research@modushealth.com.
!
StepWatch™ is listed with the U.S. FDA as a Class II exempt medical device. 


A. Care of the StepWatch™ Hardware

The StepWatch™ 3 is designed to provide maintenance-free performance for the life of the 
product. With proper use and care, StepWatch™ 3 is limited only by the battery life, which is 
typically up to seven years. The StepWatch™ is warrantied against manufacturing defects for a 
period of two years from the date of purchase. 
!
Temperature extremes, particularly high temperatures, will reduce battery life. Avoid leaving 
the StepWatch™ in hot places over 115º F. Maximum life is achieved at room/body temperature. 
!
WARNING!  NEVER PLACE THE STEPWATCH™ IN ANY TYPE OF OVEN OR AUTOCLAVE as this 
could potentially cause the permanent lithium battery to rupture or explode.
!
The StepWatch™ is designed to withstand typical handling and real-life wear and tear. Factory 
calibration is permanent and won't change during normal use. However, the StepWatch™ is a 
sensitive instrument and should be treated with care and respect to maintain the highest 
possible accuracy. Extreme shock/vibration may affect the sensor threshold, which could 
decrease accuracy. For example, avoid severe drops onto concrete and putting the unit through 
a clothes washer or dryer cycle.
!
The StepWatch™ 3 is water resistant, but not waterproof. It should never be submersed in/or 
subjected to large quantities of water. 
!
Do not apply any covering (tape/stickers) or writing (marker/paint) to the front red cover 
of the StepWatch™. The StepWatch™ communicates with the docking station (dock) through 
the red cover and any obstruction could compromise the quality of recorded step data. 


1. Cleaning and Sanitizing

The StepWatch™ monitor may be cleaned using a cloth dampened with mild soap and water or 
70% isopropyl alcohol. Strong detergents or solvents will damage the plastic and will void the 
warranty. NEVER soak the StepWatch™ in any type of cleaner or solvent. WARNING! NEVER 
PLACE THE STEPWATCH™ IN ANY TYPE OF OVEN OR AUTOCLAVE, as this may cause the 
battery to rupture or explode.
!
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The dock is NOT water resistant or waterproof. The StepWatch™ dock may be cleaned using a 
cloth dampened with mild soap and water or 70% isopropyl alcohol. Strong detergents or 
solvents may damage the plastic and will void the warranty. Do not soak the StepWatch™ dock 
in any type of cleaner or solvent. NEVER PLACE THE STEPWATCH™ DOCK IN ANY TYPE OF 
OVEN OR AUTOCLAVE, as this may cause the battery to rupture or explode.
!
The StepWatch™ straps may be hand washed with mild soap and water, or a solution of 70% 
isopropyl alcohol. Do not use machine washing or drying, as this may cause shrinkage and 
hasten deterioration. 


2. Service and Repair

The StepWatch™ and the dock are not user-serviceable. Opening or tampering will void the 
warranty. Contact SPS Technical Support at (800) 767-7776 for assistance with a StepWatch™ or 
dock.


3. Disposal

This symbol on the product or on its packaging indicates that this product must 
not be disposed of with your other household waste. Instead, it is your 
responsibility to dispose of your waste equipment at a designated collection point 
for the recycling of waste electronic and electrical equipment. The “Li” designation 
on the symbol indicates the presence of a lithium battery.
!

Lithium battery warning: Fire, explosion and burn hazard- do not short-
circuit, recharge, incinerate, expose to temperatures above 212ºF, disassemble, 
puncture or expose contents to water. Dispose of the battery properly.
!

B. Modus Trex™ Dock and Software Installation Instructions 

Attention: To download Modus Trex Software, please go to: www.modushealth.com/
trexsupport and choose the PC or Apple version.
!
Modus Trex™ software version 3.4 supports the following operating systems:


• Microsoft Windows XP SP3 (features may be limited), Vista, Windows 7, Windows 8+

• Apple OS X 10.7+
!

Read the instructions for your operating system completely before using Modus Trex™. Do not 
plug in the StepWatch™ dock until noted in the following instructions.
!!

1. Installation Instructions for Windows XP SP3+

Attention: Windows XP SP3 must be connected to the Internet to install Modus Trex™.

1.  Double-click the Modus Trex Installer.exe from the download website 
www.modushealth.com/trexsupport.

2.  Click “Next” on the following three screen, adjusting the install location if desired:




 

!  4

Clinician User Guide, Rev. A, 05/27/2015  !



Windows Vista+: If prompted by User Account Control to install the software, choose “Yes”:
!

� 
!
Windows XP SP3: If prompted by Software Installation that the software has not passed Windows 
Logo testing, choose “Continue Anyway” -- this may appear twice:
!

� 
!
4.  Click “Finish” on the final installation screen. Modus Trex™ is now installed. At this time, 
you may plug in the StepWatch™ dock. Wait 30 seconds for the StepWatch™ dock to be 
detected (the blue light will stop blinking and turn steady). You are now ready to launch Modus 
Trex™ -- a shortcut has been created in the Windows Start menu and on your desktop.

 

Attention: Never plug in or unplug the dock while the Modus Trex™ software is running. 
Always close the software before plugging in or unplugging the dock.


2. Installation Instructions for Apple OS X 
!
1.  An OS X driver package has been provided with the Modus Trex™ 3.4 software. 
“StepWatchDockDriver_OSX_Intel_2218.zip”. Double-click this file to extract the driver 
installation software “StepWatchDockDriver_OSX_Intel_2218.mpkg” into the same directory.

 

2. Double-click the driver installation software “StepWatchDockDriver_OSX_Intel_2218.mpkg” to 
run the installation. Follow the installation routine until the driver has been installed.

3. Restart your computer.

 

4. Using the enclosed USB cable, plug the dock into a USB port on the computer. The blue light 

!  5

Clinician User Guide, Rev. A, 05/27/2015  !



on the dock will illuminate and then stop blinking and turn steady when correctly detected by 
the computer.
 !

Running the Modus Trex™ Software
!
The Modus Trex™ software is a “standalone application package” Like all OS X apps, it will run 
in any directory on the computer once downloaded from the www.modushealth.com/
trexsupport website. You are encouraged to copy the ModusTrex.app package from the website 
or from the location where you’ve downloaded it into the Applications directory on your 
computer. This is standard convention to “install” apps on OS X.
!
1.  Start the software by double clicking on ModusTrex.app.

 


Note: On some computers, you may receive a warning about running an app from 
an unidentified developer. If you receive this warning, click “OK” to close the 
warning. Then, right-click on ModusTrex.app and left-click on “Open” (as 
opposed to double clicking on the icon to open it). This will present a similar 
warning notifying you that the app is not from an identified developer, but unlike 
the standard warning there is now an “Open” button that will allow you to launch 
the app. OS X should remember this approval going forward.


 

Attention: Never plug in or unplug the dock while the Modus Trex™ software is running. 
Always close the software before plugging in or unplugging the dock.
!

3. Connecting and Using the Dock

The StepWatch™ application should not be running when you plug in or unplug the dock.
!
CONNECTING THE DOCK

Connect the dock to your computer BEFORE launching the software. The Modus Trex™ software 
should NOT be running when you plug in or unplug the dock

- BLUE LIGHT: Dock is plugged in, but not communicating with the software. If only 

the BLUE LIGHT is on, try selecting the communications port labeled “StepWatch 
Dock” in the software preferences on the Communications tab.


- RED LIGHT: StepWatch™ is busy, DO NOT REMOVE the StepWatch™.

- GREEN LIGHT: Dock is connected but StepWatch™ monitor can be safely 

removed.
!
PLACE THE MONITOR ON THE DOCK

Place the monitor face down into the depression on the dock. You do not 
need to remove the strap.
!!
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! 
!
If the dock was not detected, you will get this screen:


� 
!
If this occurs, please contact SPS Technical Support at (800) 767-7776 for assistance.
!
The StepWatch™ 3 dock does not require external power. It draws power from the USB 
connection with the computer.


!
!
!
!
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C. Setting Preferences

Before you start to collect data, we recommend familiarizing yourself with each of the following 
preference options, because they affect how the data are recorded, displayed and analyzed. You 
may change your preference settings by choosing “Preferences” from the “Edit” (Windows) or 
“StepWatch” (OS X) menu.
!

� 
!
1. Programming


� 


a. Units

Select either English or Metric units. This will affect both height measurements (inches or 
centimeters) and date formats (order of day and month, and characters separating day, month 
and year). The date format you choose should be the same as that used by your computer 
operating system. (The European date style may not display in all locations where dates 
appear.)


b. LED Flashes

The StepWatch™ is equipped with a red diagnostic LED at the top of the unit to help you 
determine if the programmed settings are applicable to a given patient. The LED blinks each 
time a step is detected. You should use the LED flashes to quickly assess the appropriateness of 
your settings by watching your patient walk and ensuring that the light blinks once for each 
step. Be sure your patient does not try to look at the StepWatch™ while walking, because this 
creates an untypical gait pattern. 
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By default, the LED is set to blink for the first 40 steps collected after programming. When using 
Advanced Programming, this preference is overridden by the number you specify on the 
programming screen. You may specify up to 255 LED blinks in Advanced Programming.


c. Preferred Recording Duration

The “Preferred Recording Duration” preference sets the default recording time for each 
monitoring session initiated with the regular programming mode. The “Recording” window 
provides an option to change the setting for a particular monitoring session. Unless 
downloaded earlier, the StepWatch™ will always run at least this number of days.  It is 
recommended that the setting of “Memory Full” is selected so that the maximum amount of 
data is collected (50 days) should your patient not regularly use the system at home...


d. Estimated Percent Time Active

We recommend not changing this number from the default 35%. If you have extremely active or 
inactive patients and are trying to record for as long as possible, contact Modus Research 
Support for further advice at research@modushealth.com.


e. Preferred Recording Interval

This function allows you to change the steps per time interval.  For consistent reports, this 
setting needs to stay at 60 Seconds. 


f. Hide CMS functional level (K-level) scores

Checking this box will hide the Modus CMS functional k-level scores when viewing and printing 
the report.  You will still see the Modus Index scores.


2. Presentation


!  

a. Auto-Exclusions

This function allows you to specify the days with relatively few or no steps that are to be 
automatically excluded from analysis. The function only applies when data are first 
downloaded. Editing the time selection for the day in the “Edit Time” window may later include 
auto-excluded days.


b. Activity Level Definitions

All step counts are based on the steps for the measured leg. Low Activity is defined as 1 – 15 
steps/minute and is the lightest color on the Recording Summary bar graph.  Medium Activity is 
defined as 16 – 40 steps/minute and is the medium color on the Recording Summary bar graph.  
High Activity is 41 steps/minute or greater and is represented by the darkest color on the 
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Recording Summary bar graph. This allows easier visualization of peak activity.  These levels 
should not be changed or it may be difficult to compare your reports to others.
!
Note on Activity Level Definitions:

Our normative data collection on healthy persons has shown that activity limits of 15 steps per 
minute on the measured leg for Low activity and 40 steps per minute on the measured leg for 
Medium activity represented natural break points in the aggregate distributions of activity 
intensity.


c. Display Options

The “Draw Grid Lines for Step Rates” option controls whether horizontal step rate grid lines are 
drawn in the daily step plots on your screen and in printing. The “Display Activity Level as Color 
Bands” option controls whether the color bands for Low, Moderate, and High activity are shown 
in the step plots on your screen and in printing. These color bands can be helpful references for 
visual inspection of your data, but they can also be misperceived. When the line representing 
any data point passes through and beyond a given activity intensity band, that line is counted in 
the interval within which it peaks. When you change either of these settings, you will need to 
close and re-open any open files to see the effect.


3. Communications


!  
Use the pop-up menu to specify the port into which you plugged the StepWatch™ dock. You 
may verify whether your selection is correct with the check dock function in the 
“Communications Test” of the Monitor menu or by verifying that the green light is illuminated 
on the dock. If the software does not detect the dock, contact SPS Technical Support at (800) 
767-7776 for assistance.


!
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E. Programming the StepWatch™
!
As the clinician, select “StepWatch Provider Options”


                                       � 
!
Easy Start is accessed through the "Start Recording Activity" command in the Monitor menu.

 


� 

To initiate “Easy Start” programming place the StepWatch™ face down on the dock and select 
“Start Recording Activity” from the “Monitor” menu. The software will read programming 
information from the StepWatch™ and the dock will show a red light while it is communicating. 
DO NOT MOVE THE STEPWATCH™ WHILE THE RED LIGHT IS ON. This will take a few 
seconds. The Start StepWatch™ screen will then appear. Complete the patient description.
!

  � 

Prior to programming you should confirm that you have set the preferences as you wish. (See 
“Setting Preferences” earlier in this manual.)  
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1. Describe Subject


a. Height

This setting strongly affects the maximum rate at which the StepWatch™ can identify steps. In 
general, a person's height is inversely related to step rate, meaning a taller person will often 
have a slower step rate than someone shorter. If you do not know your patient's height and you 
specify an incorrect value, the steps recorded may not be accurate.


b. Stride length

Stride length is needed to calculate distance 
walked on the functional report.  Stride length is 
the distance between two successive placements 
of the same foot.
!
Stride length can be estimated by measuring the 
distance walked by your patient for several 
strides (usually 4 to 10) and then dividing this 
distance by the number of strides.

There are also web applications that use video of 
walking to determine stride length such as PnO Data Live (https://live.pnodata.com).  


c. Quick Stepping

A key to accurately identifying quick stepping activities is to distinguish overall walking speed 
from how quickly steps are being taken. Some activities, such as fast walking with long strides, 
involve traversing the ground rapidly without taking steps much more quickly than moderate 
walking with shorter strides. Other activities, like vigorous dancing, involve moving the feet 
quickly without the body traversing the ground quickly.
!
It is also important to distinguish activities the patient likes or knows how to do from those 
they are likely to undertake during the monitoring session.
!
Indicating YES for the “Quick Stepping” setting has a fairly strong affect on the 
StepWatch™ performance. If you are uncertain, choose NO. If you are in question about 
whether an activity qualifies, have the patient "demonstrate their moves" and adjust 
accordingly. 
!
Examples of quick stepping activities might be:
!

• Running or jogging with a short and/or rapid stride

• Vigorously playing sports such as basketball, soccer, volleyball, racquetball, tennis

• Jumping rope (with more than one jump per rope cycle)

• Romping energetically with a child or dog

• Fast dancing

• "Spinning" on a bicycle

• High-impact aerobics


d. Walking Speed

NOTE: Answering YES to “Quick Stepping” overrides and disables this option.
!
Evaluating a person's normal walking speed relative to their height may be an unfamiliar 
concept. The intent is to identify how quickly steps are being taken rather than the absolute 
speed at which a person traverses the ground. Comparing extremes in height helps illustrate 
the concept. Consider a small child, an average height mother, and a very tall father walking 
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together at the same speed. If they are maintaining the mother's normal comfortable speed 
(and all are unimpaired), the child would be walking quite quickly relative to his height, and the 
father would be walking slowly relative to his height.
!
Apply that concept to your patient. For her height, is her normal walking speed slow, average, 
or fast? Most people will fall in the average category.


e. Range of Speeds

NOTE: Answering YES to “Quick Stepping” overrides and disables this option.
!
This setting influences how broad a range of step rates the StepWatch™ will "expect". For most 
people, a moderate range is appropriate. Some patients, however, rarely change their walking 
speed because of habit, preference or, most commonly, physical limitations. It is more difficult 
to evaluate whether a person "regularly engages in both extremes". The following examples 
may help with the determination. Remember, a person must regularly exercise BOTH extremes 
to qualify.
!
Examples of the slow extreme might be:
!

• Walking with a slow-moving elderly person

• Walking with a young child

• Meandering, window shopping

• Slow pacing with a long stride
!

The key is to identify whether the person regularly walks such that the leg is in the swinging 
phase for a long time.
!
Examples of the fast extreme might be:
!

• Fast walking (e.g. for exercise or within a job that requires moving quickly through 
large spaces)
!

• Jogging or running with a fairly long stride (Note: if a person regularly runs with a short 
rapid stride, the Quick Stepping designation will be YES and the Range question will not 
be relevant)
!

• Bicycling with a moderately fast cadence
!
• Exercising on a Stair Master
!

NOTE: Bicycling appears to the StepWatch™ as walking. If a person regularly bicycles, they 
should remove the StepWatch™ during bicycling unless you would like their bicycling counts to 
be included in the gathered step data. If you choose to include the data, you may want to 
investigate how quickly they pedal – “spinning” versus moderate pedaling versus slow pedaling, 
for example – as the data gathered under these conditions may be affected by this setting.


f. Leg Motion

Observe how the patient moves in your presence.
!
It is the motion at the leg and ankle that is most relevant, since that is what the StepWatch™ will 
be sensing. Look at the motion of their leg/ankle rather than their entire gait.
!
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• Dynamic/fidgety: If your patient is especially fidgety or tends toward quick, abrupt 
movements, use the "Fidgety and/or Dynamic" setting. Most children fall into this 
category. This setting may also be appropriate for people who are foot tappers, 
especially heel tappers.
!

• Gentle/geriatric: If your patient moves very slowly or gently, use the "Gentle and/or 
Geriatric" setting. This designation may also be appropriate for people who regularly 
undertake activities with subtle steps (usually in confined areas) if you are having 
trouble "capturing" those steps. Examples of those types of activities might be:


- Working behind a counter or at a workbench

- Dancing gently

- Cooking in a small kitchen
!

If you are unsure, program a monitor with the "Normal" setting and put it on the patient. 
Have them demonstrate their movements. Watch whether the StepWatch™ light blinks 
when they take steps. If you are regularly missing steps, try using the "Gentle and/or 
Geriatric" setting.
!
Be careful about assuming a "Gentle and/or Geriatric" setting for persons who walk with 
a prosthesis, walker, cane or crutches. It is important to watch the motion of the leg in 
these cases. Often the leg swings forward fairly rapidly and a "Normal" setting is 
appropriate. "Normal" is also appropriate for older people whose ankle and leg motion is 
flexible.
!

• Normal: Most people fall in the "normal" category.


2. Set Start Time, Recording Interval, Duration


a. Recording Time

Before initiating programming, you have the option of changing when the monitor will start and 
stop recording.  You will want to record steps every 60 seconds and stop recording when 
memory is full.  The memory will become full after 50 days of recording.  You may later print 
weekly reports with the 50 days of data.  These settings can be set as the default values in 
“Preferences.” 


3. Subject Information


a. Unique ID

Entering a unique ID is optional.  Using a unique ID may be helpful in keeping the functional 
reports associated with the correct patient. 


b. Age

Enter the current age of your patient.  This is needed in order to compare your patient’s Modus 
Index score to the correct normative age group.


c. Weight

Enter the current weight of your patient.  This is needed in order to correctly calculate the 
ambulatory energy index.


d. Gender

Select the gender of your patient.


e. Diagnosis

Select your patient’s type of amputation.  Use other if the type is not listed.
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f. Subject Name

Entering your patient’s name is optional.  


4. Initiate Programming

When you are satisfied with your settings, click the Start button to initiate programming. 
Programming will take up to 30 seconds. When programming is completed, the red light on the 
dock will no longer be illuminated and the green light on the dock will illuminate. The software 
will present a window verifying when recording will start. You should now remove the 
StepWatch™ from the dock and attach it to the patient. By default, the StepWatch™ will not 
start recording steps until one minute after the “success” dialog window. This minimizes 
recording false steps from motions applied to the StepWatch™ during patient attachment.


5. Verify the Settings

Once the programming is completed, you may wish to confirm the appropriateness of your 
settings by watching the LED blink one time per step as your patient walks at their normal 
speed. You may also have them walk at the “slowest pace they would normally walk” and the 
“quickest pace they would normally walk.” Your patient should not look at the monitor while 
walking, as this will change their walking pattern. You should watch to see that the StepWatch™ 
is not double blinking on slow steps, and not skipping a blink on fast steps. If you are walking 
with your patient, do not lead them or trail too far behind as this may influence their natural 
pace. If possible, stand still at the front, back or side and simply observe.
!
Once a monitor has been programmed, do not double-check settings by reading recorded 
activity or reading current settings. Both of these actions will stop the recording and will 
put the StepWatch™ to sleep. No data will be logged until the monitor is reprogrammed.
!
If you have programmed a StepWatch™ to start recording but it has not yet begun, do not 
try to read recorded activity until it has had time to record at least one minute.
!
If the StepWatch™ is not detecting steps as accurately as expected and attempts to adjust 
the Easy Start parameters do not improve accuracy, review “Verify Cadence and Sensitivity 
Settings” in the  “Advanced Programming” section in this manual. 
!
The key to getting optimal results is balancing the Motion Sensitivity and the Cadence 
settings. For questions, contact modus for advice at research@modushealth.com. Virtually 
any gait style can be monitored accurately, but the difficult ones require more in-depth 
understanding of how the settings relate to each other and respond to particular gait 
styles.


F. Wearing the Monitor

The StepWatch™ 3 should be worn on the outside or inside (medial or lateral) aspect of 
the prosthetic leg just above where the ankle bone would have been. Wearing on the 
lateral side is usually preferred.
!

• Be sure the StepWatch™ is oriented PROPER SIDE UP by observing the direction of 
the arrow on the case. It will not record data when it is upside-down. Take some 
time to instruct your patient about monitor orientation and to assure that they 
understand. 
!

• The StepWatch™ is not waterproof.  If the prosthesis is worn in the shower, the 
StepWatch™ should be removed.
!

• Do not apply any covering or writing to the front red cover of the StepWatch™.
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!

� 


II. General Data Information


A. Download Data

Place the monitor face down on the dock and select “Read Recorded Activity” in the Monitor 
menu to download the data from your StepWatch™. This may take a few seconds to minutes 
depending on file size.
!
Do not remove the monitor from the dock while it is communicating (while the red light 
on the dock is on).
!
If you are unable to read a monitor see “Troubleshooting” in this manual.
!
If you accidentally select "Start Recording Activity...” when you mean to read recorded activity, 
allow the communications to continue until the start StepWatch™ screen appears, then click 
cancel. Your data will not be compromised. Read the monitor again.


!
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B. Generating Your Activity Report
 !
If it has been at least 5 days and you wish to view your patient’s Trex™ report, place the 
StepWatch™ in the docking station as illustrated in the following diagram. 
!


!!!!!!!!!!!!!!!!!!
Do not remove the monitor from the dock while it is communicating (while the red light 
on the dock is on).
!
As shown in the following diagram select “View Report and Restart StepWatch™” to view your 
Trex™ report.  The steady red and blue lights will appear on the docking station if your walking 
information is transferring to your computer. The StepWatch™ will record a maximum of 50 
days and stop recording data if not downloaded in 50 days.
!

� 


!
!
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C. View Data and Generate a Functional Level Report
!
When the data have been read you will see 3 tabbed windows.


� 

• “REPORT” includes the monitor ID, the time the monitor was programmed and read, 

unique ID, patient name, demographic information, and the functional level scores / 
metrics for the patient. You MUST specify a clinical functional walking level 
observation score to generate the scores for this report. Click the checkbox for the 
observed score and the report will automatically update with all functional level scores.  
The patient cannot change your functional level selection when using the patient 
features.
!

• “RECORDING SUMMARY” includes more detailed information about the monitor and 
recording session, including a list of days the monitor was running and a graphical 
representation of the data for each recorded day.
!

• “EDIT TIME” graphically shows minute-by-minute step plots of each day and allows 
you to select the time that will be included in your analysis. Double click on any day to 
access tools for including or excluding the day, or parts of the day, in your analysis. 


D. Representations of the Step Data


1. Graphical Representations of the Data

There are several tools providing graphical representations of the data. For a more complete 
understanding of the analysis calculations see “Analysis Variables and Calculations” in this 
manual.


a. Daily Step Plots 


!  !
Daily Step Plots show the raw data for each day with time (on 24 hour clock) across the bottom, 
and steps per minute on the vertical axis. Each small vertical line is one minute. The data 
represent step counts only for the leg being monitored.
!
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b. Modus Index Bar Charts 


� 
!
The bar charts display the overall functional level index (Modus Index), the ambulation energy 
index, the peak performance index, and cadence variability index.  Each bar chart has a vertical 
line representing the 50th percentile score for healthy persons with both limbs in the same 
decade of life as the prosthetic user.  The 50th percentile scores were calculated from n=199 
participants with 29 – 32 participant in each decade of life except the 80 years old or older 
group, which had 15 participants. This data was collected in Seattle, Washington, and 
surrounding areas.


E. Filtering Data for Analysis


� 
!
To specify which data you want included in your analysis, use the “Days to Include” feature on 
the “Report” tab.  This provides the quickest method for analyzing a cluster of days.  If a more 
complex filtering process is required, click on the “Edit Time” tab of your data file. This shows a 
step plot for each day recorded with time (on a 24 hour clock) along the bottom and steps per 
minute on the vertical axis. Each data line indicates the number of steps taken in 1 minute (1 
minute is the default). If you are using the “Auto Exclude” option in “Preferences” you may see 
that some days are excluded already.


1. Change Included Time

To change the time that is included or excluded in your analysis, double click on any day in the 
“Edit Time” window. An editing time window will open where you may alter the time that is 
included in a variety of ways:
!

                � 
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a. Start/Stop Bars

Use your cursor to drag the “Start Time” and “Stop Time” bars across the plotted data. If you do 
not see these bars, they are at both ends of your plotted data. Move the cursor to either end 
until it becomes an " I " shape. Hold the mouse button down and drag. Release the button when 
the bar is in the desired location. You can use the digital time controls for fine adjustments.


b. Digital Time Controls

Use the digital time controls by clicking on the hour or minutes indicator for the start or stop 
time, then click on the arrows to the right of the numbers to control the number.


c. Include/Exclude Day

Click the "Include Entire Day" or "Exclude This Day" to achieve the desired result.


d. Include/Exclude Range

Use the “Include Range” or “Exclude Range” toggle buttons to control whether the time between 
your “Start” and “Stop Time” bars is included or excluded for analysis.


e. Reset to Original

Use the "Reset to Times Recorded” button to reset the day to the original state. This can be 
especially useful for partial days at the beginning and the end of a recording session.


f. Make All Days the Same

The "Make All Days the Same" check box applies the time selection for the day being edited to 
all the days in your file. This function can save time (and clicking).
!
When you are satisfied with your time selection, click the OK button.
!
F. Analysis Variables and Calculations


1. Metrics

All step counts, for which the metrics are derived, are for the measured leg only. The metrics 
are based on the whole and partial days you have chosen to include for analysis. Days that are 
entirely excluded will appear in italicized text in the Recording Summary tab and will not be 
included in the Date Range.  Excluded days are not included in the metric calculations.


a. Clinical Observations

The clinician’s opinion of the patient’s functional level based on clinical judgment and patient 
self-report. The patient cannot change your functional level selection when using the patient 
features.
!

!  
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b. Modus Index

Overall walking function of patient.  Its value is on a 0 to 100 scale with comparisons to 
normative values of healthy persons with intact, unimpaired limbs, of the same age decade 
(50th percentile).  It is comprised of clinical observations, Ambulation Energy Index, Peak 
Performance Index, and Cadence Variability Index.  The 50th percentile is comprised of 
Ambulation Energy Index, Peak Performance Index, and Cadence Variability Index only.


c. Modus CMS Functional Level Score

Overall walking function of patient in terms of Centers for Medicaid and Medicare Services 
(CMS) Functional K-level score. This score is comprised of clinical observation k-level score, 
Ambulation Energy CMS Functional Level Score, Peak Performance CMS Functional Level Score, 
and Cadence Variability CMS Functional Level Score.  The score should be rounded to the 
nearest whole number when determining k-level category: 0, 1, 2, 3, or 4.  For example, a CMS 
Functional Level Score of 2.5 – 3.4 would be rounded to a k-level score of 3.  The CMS 
Functional Level Score within the range of 3.5 – 4.9 would have a k-level score of 4 since this is 
the highest functional category.  The CMS Functional Level Score is intended to provide an 
objective and standardized process determining patient’s CMS Functional Level category.  


d. Ambulation Energy Index

Algorithm that incorporates ambulation energy requirements and intensity of continuous 
walking bouts. Its value is on a 0 to 100 scale with a comparison to normative values of healthy 
persons with intact, unimpaired limbs, of the same age decade. 


e. Ambulation Energy CMS Functional Level Score

Algorithm that incorporates ambulation energy requirements and intensity of walking bouts. Its 
value is scaled to the CMS Functional Level categories.


f. Peak Performance Index

Algorithm that incorporates fastest 1-minute walking spurts. Its value is on a 0 to 100 scale 
with a comparison to normative values of healthy persons with intact, unimpaired limbs, of the 
same age decade. 


g. Peak Performance CMS Functional Level Score

Algorithm that incorporates fastest 1-minute walking spurts.  Its value is scaled to the CMS 
Functional Level categories.


h. Cadence Variability Index

Algorithm that incorporates proportion of walking at low (1 – 15 steps per minute), medium, 
(16 – 40 steps per minute) and high (41 or greater steps per minute) cadence values. Its value is 
on a 0 to 100 scale with a comparison to normative values of healthy persons with intact, 
unimpaired limbs, of the same age decade. 


i. Cadence Variability CMS Functional Level Score

Algorithm that incorporates proportion of walking at low (1 – 15 steps per minute), medium, 
(16 – 40 steps per minute) and high (41 or greater steps per minute) cadence values. Its value is 
scaled to the CMS Functional Level categories.


j. Daily Steps

Average of daily steps on the measured limb.


k. Date Range

All the dates included in the metric calculations. “Custom date selection from Edit Time” will be 
displayed if Edit Time was used to select the days for inclusion in the calculations. 
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l. Cadence

Average steps per minute when walking. Walking is defined as greater than or equal to 1 step 
per minute.  Very low cadence rates indicate slow walking and/or walking that does not often 
continue for a full minute. An increase in Cadence indicates the patient is walking at faster 
speeds and/or walking longer in continuous bouts. 


m. Cadence Variability

Average standard deviation of cadence when walking.  Walking is defined as greater than or 
equal to 1 step per minute.  An increase in cadence variability means the patient has increased 
their range of walking cadences.  This typically occurs when the patient’s cadence rates reach 
new peak cadences that exceed the peak cadences from previous weeks


n. Daily Distance

Average distance walked per day. Distance is based on Daily Steps and patient’s typical stride 
length inputted by the clinician during setup.  


o. Stance/Swing Time

Average stride duration (time from foot contact of measured limb to foot contact of same limb) 
based on the fastest 1 minute of walking each day.  Very long stance/swing time estimates will 
occur if the patient does not walk for at least one continuous minute each day.  A decrease in 
stance/swing time means the patient is taking less time with each step. 


2. Handling Data Files


a. Save and Save As

The “Save” command on the Report and under the File menu allows you to save step data to a 
file on your computer and to save alterations to a file already existing on your computer. If the 
file does not already exist on your hard disk (i.e. the data have just been read from the 
StepWatch™), a window will open that allows you to name the file and choose where to save it. If 
you are saving a file that you have opened from your computer, you will not be asked to name 
or choose the location for the file.
!
The “Save As” command under the file menu allows you to name and choose the location for 
saving a data file on your hard disk. This allows you to assign a new name to a data set. This is 
useful, for instance, if you have changed the time included for analysis and want to preserve 
both the old and new versions.
!
With either “Save” or “Save As”, the specifications for the time you have chosen to include or 
exclude for analysis will be saved with the file. The excluded data will not be lost and will be 
available for inclusion later.


b. Opening and Closing Files.

• Open: The Open command allows you to open a StepWatch™ Modus Trex™ data file.


On Windows, all files in a directory which end with .swb will show up in the list of 
StepWatch™ Document file types showing in your Open dialog box. If you have 
StepWatch™ files which do not have the .swb extension, you may need to select "All 
Files" from the File Type pop-up menu in your Open screen. This is not typical.
!

• Open Recent: The Open Recent command allows you to quickly access any of the last 5 
data files that were saved. The Open Recent functions clears its history when changing 
Preferences or closing the program.
!
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• Close: The Close command closes the currently focused data window. If the window 
contains changes that have not been saved, you will be asked whether you want to save 
the file before closing.


c. Printing Reports


!  !
• Print: The Print command on the Report and under the File menu gives you the 

option to the print the Report Page and Summary Page without previewing them.  
This is the fastest way to print the reports.


• Page Setup: The Page Setup command under the File menu gives the standard page set 
up options applicable for your chosen printer driver. Note: on some Windows machines, 
your page margins may need to be set at zero for printing to work properly.


• Print Preview and Print: The Print Preview and Print command under the File menu 
gives you the option to view and print the Report Page and the Summary Page.  The 
Report Page contains the information from the Report tab.  The Summary Page contains 
the steps taken each day that was recorded.  Days not included in the calculations will 
have “(0 Hr. 0 Min.)” next to the day. 


III. Troubleshooting 
The Modus Trex™ program provides some tools to assist in troubleshooting including 
messages during the program operation and several diagnostic tools in the menu. Contact SPS 
Technical Support at (800) 767-7776 for assistance.


A. Communications Errors

A properly connected StepWatch™ 3 dock has a green light illuminated when the StepWatch™ 
software is open. If you do not see this light, are not able to read your StepWatch™, or if the red 
and blue lights are flashing on your StepWatch™ 3 dock:
!

• Check the connections between the dock and the computer. Try plugging the dock into 
another USB port on the computer.
!

• Verify that your Communications Preferences have the correct port specified: Choose 
“Preferences” from either the Tools menu (Windows) or the StepWatch ™menu (OS X) 
and then click on the “Communications” tab. Click the “Set to Default Values” button, 
followed by pulling down the “Connect to dock via” menu and selecting the entry for 
“StepWatch™ Dock” (Windows) or “usbserial-NNNNNN“ (OS X). Then click the “Done” 
button. The green light on the StepWatch™ dock should now be illuminated.
!

• Verify that the computer can communicate with the dock and the StepWatch™ by using 
the “Communications Test” below.
!

• Make sure the StepWatch™ is properly aligned on the dock.
!
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• Make sure there are no bright lights shining on the StepWatch™. Halogen lights can be 
especially troublesome. The infrared lights of some motion analysis systems also make 
shielding necessary.


B. Communications Test

You may use the Communications Test (in the “Tools” menu) to check that your 
communications preferences and hardware are set up correctly and the StepWatch™ software is 
able to "talk to" the dock and StepWatch™.
!

• Click the "Check Dock" button to verify that your computer is in communication with 
the dock. You do not need to have a StepWatch™ on the dock to do this.
!

• You may click the “Check StepWatch™“ button to verify that your StepWatch™ is 
properly communicating. The “Advanced Settings” should only be used with guidance 
from SPS Technical Support.


C. Read StepWatch™ Settings

Use the “Read Settings and Put to Sleep” option in the “Utilities” section of the “Monitor” menu 
to quickly verify the settings in your StepWatch™ memory. Use this test on a StepWatch™ that is 
asleep or has not recorded any data. Do not use this to verify the settings after you have 
programmed a monitor, as it will stop the monitor from recording. This function is intended to 
provide a means for conveniently checking the settings or notes in the memory of a monitor not 
in use. You can also use it to verify that a StepWatch™ is asleep and see the threshold 
calibration.
!
Alternatively, use the “Read and Restart with Previous Settings” option to read the StepWatch™ 
monitor memory settings and reprogram it with the current settings. This is useful to double 
check the settings of a monitor which was just set to record and set it back into the recording 
state with those settings instead of putting it to sleep. Do not perform this test on a monitor 
which has recorded data, the data WILL be lost.
!
Caution: Always wait 60 seconds before reading a monitor that was just set to record.


D. View Communications Log

The Communications Log keeps a record of each time you program and download a 
StepWatch™.  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Appendix A: Hardware Specifications 
A. StepWatch™ 3 Activity Monitor Specifications

Size 
 
 
 
 75 x 50 x 20 mm

Weight 
 
 
 38 grams

Battery 
 
 
 750mAh Lithium

Battery Life 
 
 
 Up to 7 years depending on use

Accuracy 
 
 
 >98% independently validated

Housing 
 
 
 Injection molded polycarbonate

Attachment 
 
 
 Highest accuracy at ankle, Velcro strap

Recording Time 
 
 Up to 50 days minimum at 60 second resolution

Resolution 
 
 
 1 minute is standard, user adjustable from 3-180 seconds

Memory 
 
 
 32KB, includes 64-character user notes field

Temperature 
 
 
 Operating 0º to 50ºC / 32º to 115ºF

Shock / Drop 
 Avoid severe shocks and drops

Tamperproof 
 
 
 Permanently sealed

Water resistant 
 
 Yes

Waterproof
 
 
 No

Factory refurbishable 

 No

U.S. FDA 
 
 
 Listed with the FDA as a Class II exempt medical device


B. StepWatch™ 3 Dock Specifications

Size 
 
 
 
 106 x 68 x 31 mm

Weight 
 
 
 150 Grams

Communication 
 
 USB to computer, IR to StepWatch™

Batteries 
 
 
 Not required

LED status indicators 

 3
!!
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!!
MODUS HEALTH LLC


1054 31st Street, NW

Suite 318


Washington, DC 20007

202.830.1100
!
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